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1 Introduction 
1.1 Manuals and Help 

The following information will help you to understand Nigra for Sprinter and work successful-
ly. Nigra for Sprinter, your software for the evaluation of levellings. 

Getting Started Guide. The book you are reading now. The Getting Started Guide contains 
a general overview, system requirements, installation instructions and first steps to use Nigra 
for Sprinter. 

Reference Manual. The reference manual is available as .PDF file to read or print with 
Acrobat Reader. The manual contains detailed technical information for all items of the Nigra 
standard version. 

Online Help. To access the Nigra help, press the F1 key in Nigra. 

1.2 Getting Product Support 

If you can't find an answer in the section Questions and Answers in the online reference or 
on our website http://www.trukksoft.de, write an e-mail with your question to 
mail@trukksoft.de or send a fax to 0049-2241-315954. We can only answer if your question 
is in English or German language. 

1.3 General Overview 

Nigra for Sprinter is a special software for the evaluation of levellings performed with the 
digital levels Leica Sprinter 100M, 150M, 200M, and 250M. 

Identical in construction to the Leica Sprinter are the levels Geozone Geomax ZDL 700 and 
Stonex D2. 

Nigra for Sprinter encloses all features of the Nigra standard version, except the following: 

Support of Leica NA, DNA and LS levels, support of Trimble, Sokkia and Topcon levels, 
evaluation of movements, creating of profiles, and creating a network file for Nivnet. 

When Nigra is used in the following, Nigra for Sprinter is always meant. 

Nigra from version 6.0 runs under the operating systems Windows 7/8/8.1, 10, and 11. 

Nigra has international features: The texts for all printouts are stored in separate data files 
and may be adapted by the user. Files for the languages English and German are included. 
Evaluations may be performed in meters, feet or inches. 

The standard way of working in connection with the Leica Sprinter: 

• Execute the levelling 

• Transfer raw data to the PC 

• Formatting of raw data into Nigra format 

• Compute the data 

The Nigra Height Database in the Microsoft Access-Format can store approximately 10 Mio. 
points per job. There is an interface for the import of heights from any text files and for the 
export of heights in the ASCII format. 

http://www.trukksoft.de/
mailto:mail@trukksoft.de
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1.4 Installing Nigra 

Before installation: Make sure that the latest Windows updates are installed on your com-
puter.  

Close all running applications. Insert the Nigra CD-ROM into the CD drive. If the Nigra setup 
does not start automatically, navigate to the appropriate folder, and run setup.exe. 

Then click on the OK button. The installation starts. 

If you got the Nigra setup from a download, unzip the zip file, and start setup.exe. 

Follow the setup instructions on the screen. If you have already installed an older Nigra 
version, choose a different installation folder for Nigra version 7.0 and higher than for the 
earlier versions. This way you can continue to work with both versions in parallel for a while 
and gradually switch to Nigra 7.0. 

When updating a Windows version of Nigra from 7.0, install Nigra in the same folder as the 
previous version. 

Nigra requires the .Net Framework 4.7.2 or higher to run. If this is not available on your PC, it 
must be installed separately. 

After the installation is complete, an entry is created in the Start menu and an icon on the 
desktop. Double-click on the Nigra icon to start Nigra. 

After installation: The Nigra templates folder is installed by default in c:\programs 
(x86)\nigra\templates. Copy the complete folder to another location (drive or folder) where 
you have full access rights. Then change the template folder entry in Nigra under Options, 
Program Configuration, Misc. to the new folder. 

c:\programs (x86)\nigra = Nigra installation folder 

1.5 Uninstalling Nigra 

To uninstall Nigra, proceed as follows: 

Click on the item Settings in the Start menu, then on Control Panel. Make a double-click on 
the icon Add/Remove Programs. In the box below select the line which contains the name 
of the Nigra software and click on the button Add/Remove. In the dialog box Select Unin-
stall Mode select Automatic and click the Next button. Then follow the description in the 
following dialog boxes. 

All files installed by Nigra will be removed. Files which are created after installation of Nigra 
will not be deleted. Therefore, the Nigra folder will not be deleted. You can remove this folder 
manually after the uninstall procedure is finished. 

1.6 Starting Nigra 

Start Nigra by clicking on the Nigra icon in the program’s menu. 

1.7 Quitting Nigra 

You quit Nigra by clicking on Exit in the File menu. Alternatively, you may quit Nigra by 
pressing the keys [Ctrl]+[F4] if all Nigra windows are closed. 
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2 First Steps 
2.1 Setting Program Parameters 

When first starting Nigra, it is advisable to make some program customizations and alter the 
standard parameters. Select the Program Configuration item in the Options menu. The 
parameters are stored in the Windows Registry, separately for each user. 

Setting Program Parameters 

The individual input fields have the following functions: 

Company - Name of Company defines a header for all printouts (for example, company 
name and address). 

Header graphics allows defining a graphics to be printed in the head of a printout (calcula-
tion, movement list, etc.) in addition to the company name. Graphics name defines the 
complete file name of the graphics (including drive and folder). Alternatively, you can double-
click on the input field or click on the button on the right side to open a selection dialog box. 

In the field Graphics dimension, you can define the size of the graphic (width and height). If 
these values differ from the original graphic size, the graphic will be resized in the printout. 

The graphic will be printed with right justification. If you print from the editor, the graphics will 
not be printed. 
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Error Limits: 

Error limits defines the boundary values according to the most used formula: (example of unit 
of measurement "meters") 

        Misclosure E (in mm) = a + b * D (in km) 

(a = constant error part in mm, b = systematic error part in mm, D = levelling distance in km) 

 

The error limits for the four error classes can be defined in free formula style as a function of 
the levelling distance D, for example, 2 + 3*Sqrt(D). "Sqrt" means square root and D the 
levelling distance in km. In modification of this standard formula, you can also calculate, for 
example, the term 2 + 3*Sqrt(D/2). 

When reformatting the digital level raw data, you may choose the error class as required. 

Admissible difference between forward and back levelling  

When creating a network file with double levellings measured, the difference is calculated 
and compared with the permissible difference. 

If you have chosen the unit of measurement "feet" or "inches", error limits will also be entered 
in these units. 

Programs: 

Transfer programs for Digital Levels, Leica: Here an entry is only required if you do not 
want to use the integrated Nigra data transfer. Enter the name of the transfer program 
supplied by your manufacturer, including file extensions. 

Editor name: An entry is only required if you do not want to use the text editor integrated in 
Nigra. In any case, the editor must be a Windows program, for example, the word processor 
WRITE. The editor must be entered completely with drive and path, for example, 
c:\winnt\system32\write.exe. 

A click on the buttons on the right will display a dialog box for selecting a program. 

In addition to these program parameters, special parameters can be defined for each job. To 
do this, however, a particular job must be opened. How to open and start jobs is described in 
section 2.2. 
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Miscellaneous (Misc.). 

 

Program Language: The language of Nigra (for menus, dialog boxes, and Help) can be 
switched between English and German. The texts for printings will not be hereby changed 
automatically. 

Nigra Background Color: Defining the individual color for the Nigra background. 

.DAT → .NIG: Changes all file extension in the current folder from .DAT to .NIG. From Nigra 
rev. 2.0, .NIG is the file extension for Nigra job files with measurement data. 

Folder for Templates: With this function you choose a folder for the template files (eng-
lish.lag, dinicode.txt etc.). The default folder created during the Nigra installation is 
c:\program files\Nigra\TEMPLATES. 

Before using this option, create the new folder and copy all files from c:\program 
files\Nigra\TEMPLATES to this folder. 

c:\program files\Nigra = Nigra installation folder 

Job folder: With this entry you can choose a folder which will be shown while opening a 
project. 

When all data have been entered, click OK. 

2.2 Opening/New Job 

Nigra works job oriented. This greatly facilitates the subsequent handling of the program, as 
all operations, for example, calculations, refer to this job, and the required parameters and 
data files are created and selected automatically. 

After starting Nigra, first create a new job or open an existing one. Choose from the File 
menu Open/New Job .... You may start a new job in any given folder by entering a job 
name or choosing an existing job (with the file extension .NIG).  

The job name will be shown, complete with the full path name, in the header of the Nigra 
window. 
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Opening Job 

The last 6 jobs opened appear in the bottom item of the File menu. If you want to use one of 
these jobs, click on the desired item. 

Several jobs may be processed within one folder. Larger jobs, however, should always be 
processed in a separate folder. 

When setting up a new job, a file is opened with the chosen job name and the file extension 
.NIG with the following contents: 

In this file your measurement data will be stored, and it is the basis for batch processing. The 
first four lines are for a better orientation, in case measurement data must be edited. Acci-
dental deletion of this lines is of no importance for further processing. 

Apart from these job files there are also job-unconnected files, for example, the raw data 
after transfer to the PC. They will be allocated to a job only after being reformatted into the 
Nigra format. 

2.3 Individual Configuration 

The individual configuration (in the Option menu, item Job Configuration) enables the user 
to adapt the program configuration to his special job. 

The individual configuration is valid for the job in use and all further jobs to be processed in 
the same folder. With this configuration you may, for example, define the units of measure-
ment (meters, feet, inches), the country-specific file for the printouts or other preset 
parameters. 

ROptional text for job description up to column 72                             

x23456789012345678901234567890123456789012345678901234567890123456789012   

x        1         2         3         4         5         6         7     

xDistance<--- Back    Side    Fore ---><--- Point Number --->              
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If you create a job in a new folder, the last used job parameters are transferred to the new 
folder. 

Defining Individual Configuration 

Reorganize calculations numbers automatically 

Check box activated: The running levelling calculation numbers are automatically renum-
bered after each reformatting of raw data. 

If there are only a few levellings entered into your measurement data file, it is advisable to 
work with the automatic reorganization function. With very large data files it is advisable not 
to activate the box and to arrange reorganization with the menu item Reorganize Calcula-
tion No. from the File menu, if required. 

Show point number extension for digital levels 

Check box activated: Shows the input field for point number extension when reformatting raw 
data. 

Print header graphics 

Check box activated: Header graphics chosen in the program configuration will be used in all 
Nigra printouts. 

Lines per page for calculations, height lists, etc. 

Fixes the number of lines per printed page before Nigra performs a form feed. 

Recommended settings for the selected font Courier New, 10 points: 60 lines per page. The 
extra lines required for a selected header graphic Nigra automatically considered when 
creating the file. 
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Text file for printouts 

All texts to be printed are taken from an ASCII file with the file extension .LAG. Standard files 
supplied with Nigra are DEUTSCH.LAG and ENGLISH.LAG. The files use the following 
format: 

*  Point Number    Height  Calc.No. Diff. NC  Date        Comments 

69,Point Number    Height  Calc.No. Diff. NC  Date        Comments 

 
The syntax is: running number, Text. Lines starting with the asterisk (*) contain comments 
and are skipped. In the example, the text (header for a height report) separated by a comma 
is allocated to the number 69. 

If you want to alter texts, do not alter the supplied files DEUTSCH.LAG or ENGLISH.LAG, 
but copy them, for example, in the file ENGLISH1.LAG and alter the newly created file. In this 
way you will avoid that your texts will be overwritten by future Nigra updates. It is possible to 
create more language files using the same method and to select them in this dialog box. 

Nigra does not work directly with the selected file *.LAG, but with an automatically created 
file Text.XML. After a text modification, this file must be created new by clicking on the button 
Update Text Database. 

Note: 
Self-created text files may have to be updated after the installation of a Nigra update. Com-
pare your own file with the file ENGLISH.LAG or DEUTSCH.LAG. 

Units of measurement 

Nigra operates with meters, feet, and inches. After program installation, the standard preset 
unit of measurement is always meters. In case you want to work with another unit, it can be 
defined in the dialog box Units of measurement. 

When reformatting the raw data of the digital level, all measurement data are automatically 
converted into the chosen unit of measurement in case measurements were taken in another 
unit of measurement by mistake. 

Although the height database originally uses meters as the unit of measurement, the in- and 
output of heights can alternatively be made in feet or inches (except heights on the screen). 

Conversion factors for units of measurement: 

Meter = Feet*1200/3937       Meter = Inch/39.37 

Feet  = Meter*3937/1200      Feet  = Inch/12 

Inch  = Meter*39.37          Inch  = Feet*12 

The unit of measurement feet above means 'US feet'. The Leica Sprinter also knows the unit 
of measurement 'international feet' (conversion factor meter in feet = 1/0.3048. When using 
this unit of measurement with a Sprinter and choosing meters in Nigra, the results will be 
wrong. When using 'international feet' with a Sprinter, choose feet in Nigra every time and 
don't change the unit of measurement. 

 

3 Levelling with Leica Sprinter 
For the evaluation of data measured with the Leica digital level Sprinter 100M, 150M, 200M, 
and 250M carry out the following steps: 
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• Transfer raw data to a computer 

• Reformat raw data to Nigra format 

• Enter heights of connecting points 

• Start calculations 

The point heights of the raw data file can also be transformed directly in the Nigra height file. 

Line Levellings with Sprinter since Firmware Version P01.01.03 

The Leica Sprinter since firmware version P01.01.03 (distributed from April 2006) supports 
line levellings with the observation sequences BF, BIF and BFFB. 

Nigra recognizes automatically during reformatting to the Nigra format which observation 
sequence was selected. If you have measured more than one levelling, carry out the follow-
ing: 

Measure to the last connection point and then an additional (fictitious) measurement to a 
point with the number A. After them you can started a new line levelling. The last levelling 
must not be finished with the point number A. 

Free turning points 

These points can be measured with the point number 0 or 1, 2, 3, etc. (in case these num-
bers are not real point numbers). The point numbers 1, 2 ,3, ... can be eliminated during 
reformatting to the Nigra format. 

Line Levellings with Sprinter (Firmware older than version P01.01.03) 

Each single measurement with the Leica Sprinter is stored in the GSI format with the code 
number 330 = single measurement. No code for back-/foresight reading or side shot is 
stored. 

To realize an evaluation as line levelling (also with side shots) certain conventions must be 
agreed on. 

On the condition that no heights will be required in the field, line levellings can be made easy 
and quickly with the Leica Sprinter in connection with Nigra. 

- Power on Sprinter – it can be measured with or without entering of a reference height. 

- Continue by pressing the MENU key, select 1. Enter PtNo, enter point number for the first 
connecting point and confirm with the MENU key. 

- Perform a measurement to the first connecting point (for Nigra this becomes a backside) by 
pressing the red button on the right side of Sprinter. 

If a reference point was first entered (with the ∆H key), the Sprinter shows 

Meas. Target! 

after the measurement to the first connecting point. Before the measurement of the 
next point first press the MENU key, enter the point number of the first measuring 
point (or foresight), confirm with the MENU key, and then press the red button on the 
right side. 

The next point is normally a foresight for Nigra. To measure a point as side shot, it is first 
necessary to measure a fictitious point with the point number Z, and then the side shot (also 
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multiple side shots). To confirm the measurement of side shots, measure again a fictitious 
point with the point number Z and then the next foresight. 

Changing the station: 

Press the MENU key to confirm the displayed point number of the last measurement. After-
wards measure the backside and continue the levelling as described before. 

Concluding a line levelling: 

Measure to the last connecting point and make another fictitious measurement to the point 
number A. 

Afterwards a new line levelling can be started by entering a point number (new first connect-
ing point). The last levelling need not be concluded with the point number A. 

Free turning points 

These points can be measured with the point number 0 or 1, 2, 3, etc. (in case these num-
bers are not real point numbers). The point numbers 1, 2 ,3, ... can be eliminated during 
reformatting to the Nigra format. 

Skipping data records 

If data records are already stored which you don't want to erase, register a fictitious point A0 
before beginning a line levelling. All data records until the point A0 will be skipped when 
reformatting to the Nigra format. In the next chapter you will learn another method of how to 
skip data records. 

Summary: 

1st point measurement = backside to first connecting point 
2nd point measurement = foresight 
3rd point measurement = backside 
..... etc. 

n.- point measurement = last foresight 

Then perform a point measurement to point A and go on with the next levelling. 

With side shots: 

1st point measurement = backside to first connecting point 
2nd point measurement to point Z = then following side shots 
3rd measurements of side shots 
4th point measurement to point Z = end of side shots 
5th point measurement  = foresight 
etc. 
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3.1 Sprinter Raw Data → PC 

Data transfer with the built-in serial com interface 

First connect Sprinter and the computer with the serial data cable. 

In Nigra: Menu Digital-Lev → Leica → NA/DNA/Sprinter Raw Data → PC ... 

In the Nigra dialog box: 

 

 

Transfer direction: 

Activate Receive data to receive data from the Leica Sprinter. 

Filename: Enter file name for data you will receive (the file is stored in the job folder) or 
choose folder and file name by clicking the button on the right.  

As a default, the date of the day without file extension is used. 

Do not define any file extensions which are in use by Nigra (.NIG, .MDB, .BER etc.)! 
Always use the standard file extensions .GSI, .NA2 or .DNA for receiving data. 

Serial interface: Selection of the serial interfaces Com1, Com2,... Com16. If a non-existing 
interface is selected, an error message is given out. 

The other parameters can be loaded with the button Load parameters. Choose the file 
sprinter.prf from the Nigra template folder. 

If all parameters are set correctly, click the OK button. In the field below of Reading data 
records, the command Start data transfer at peripheral device – Waiting for data ap-
pears. 
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On the Sprinter press MENU → Settings → RS232 (and 12. RS232 respectively for elderly 
Sprinters) and set the Sprinter parameters Baudrate, Parity, Stop Bit and Data Bit to the 
same values as in the Nigra dialog box. 

Now start the data transfer at the Sprinter: Choose DataManager → Download Data → GSI 
and start the data transfer with the MENU key. 

The data transfer starts and finishes automatically after the last record set is transferred. The 
data transfer can be aborted by pressing the Esc key or clicking on the Cancel button. 

The transferred data records will be shown in Nigra in the field Reading data records. 

The Sprinter raw data can be transferred alternatively with the Leica software Geo Office 
Tools. In this case choose the format GSI2. 

3.2 Edit Raw Data 

For editing Sprinter raw data before reformatting into the Nigra format. A dialog box to select 
a Leica raw data file appears. 

3.3 Format Sprinter-GSI → Nigra 

The Sprinter raw data format cannot be computed directly by Nigra. By activating this menu 
item, raw data will be reformatted to the Nigra format. 

In case you want to reformat your raw data in parts (if not signed with A0 during levelling), 
limit the reformatting with the letters x and e in the first column of a data record of the raw 
data file: 

x   All data records will be ignored until the next x. 
e   End of reformatting, the following data will be ignored. 

Single data can be ignored by using an asterisk (*) in the first column. 

Example for a data record in format GSI-8: 

           Point no.              Distance          staff reading 
11....+00900111 32..00+00014570 331.06+00014960 
 

The following word identification (WI)  are used for levellings with Sprinter: 

11     Point number 

330   Staff reading (Measure Only) 

331   Staff reading, backside  (since firmware P01.01.03) 

332   Staff reading, foreside (since firmware P01.01.03) 

32     Distance to staff 

83     Height of a point 

 

Nigra also processed data who are created with the Leica DataLoader with the function 
ASCII Data Listing (file extension. txt). However, the GSI format should be preferred. 
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Nigra Formats 

After the selection of a raw data file, raw data can be transformed into two different Nigra 
formats: 

- Measurements   Transfer of measurement data in a batch file for calculations 

- Height file           Transfer of levelled raw heights in the Nigra height file 

 

Reformatting of Raw Data 

Select one of the following described data formats. 

Measurement Data Format 

Raw data, supplemented with header data and parameters, are transferred in the Nigra 
batch file. 

Only for Sprinter from firmware P01.01.03: standard staff reading (Measure Only) with the 
word identification 330 are not transformed to the Nigra-format. 

After selection of a raw data file click on the Header data button if you want to change 
header data. Explanations to header data are given the Reference Manual. 

Press the Parameters button if you want to make some changes for parameters. Compre-
hensive explanations of parameters are given in the Reference Manual and in the following 
description. 

Besides GSI data also text files in ASCII Data Listing format will be transformed to the Nigra 
format. 

Point Number Extension 

During measurements with Sprinter only 8-digit numerical point numbers can be registered. 
Because often more than 8 digits are necessary, Nigra allows point number extensions, 
which are performed during the reformatting of Sprinter Raw Data → Nigra. Sometimes, 
point numbers like 12.01, 12.02 etc. may be needed. These numbers can also be generated 
by the Nigra point number extension function from the numerically stored point number in the 
raw data format. 



18     Levelling with Leica Sprinter  -  Section 3 

The functions for point number extensions are only displayed if they are activated in the 
menu item Job Configuration (Options menu). 

This method of point number extension is useful, if all point numbers of a file to be reformat-
ted are to be extended with the same character, for example when adding the movement 
period. 

After the entry of a character for the extension of the point numbers and the position (starting 
at the right) of entry, the original point numbers can be extended by any two alphanumerical 
character strings, i.e., insert numbers or letters, add, or set before. 

The position from the right in the second string refers to the point number changed by the 
first character string. 

Point numbers, which should not be changed, must be entered with a negative sign, for 
example -1248. If no point number extension is selected, the negative sign is stored together 
with the point number. 

Examples: 

Registered point number= . ..-00000230 

                          ...+00000123 

1st string= KD, position from the right = 0 or no entry 

 

New point number:                  230 

                                 123KD 

Registered point number= ...+00056005 

1st string= . (point), position from the right = 3 

2nd string= 25, position from the right = 7 

 

New point number:             25560.05 

 

Registered point number= ...+00000001 

1st string= Channel, position from the right = 4 

 

New point number:        Channel001 

 

The negative sign (for points not to be changed) and leading zeros will be removed from the 
point number. Point numbers with more than 14 digits due to point number extensions are 
cut off from the left. 

 
Removing of free turning points (turning points without numbers) 

Free turning points can be registered with the number 0. Furthermore, it is possible to elimi-
nate free turning points like 1, 2, 3, etc. by inputting a higher number in the field Remove 
turning point numbers during reformatting (only effective for format Measurements). 

Note: The last connecting point must have a higher number! 
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Defining Parameters 

Defining Parameters 

Levelling Method 

The method of levelling is consisting of the Observation sequence and the parameter 
Evaluation of side shots/turning points. Leica Sprinter supports line levellings with the 
observation sequence BF and BFFB. Nigra recognizes automatically with the help of GSI-
data which observation sequence was selected. 

If the button Evaluation of side shots/turning points is activated, the heights of side shots 
and turning points will be evaluated by batch file calculation. If not, a so-called line levelling 
will be defined. That is also valid, if line levelling BIF was selected. 

With distances check box is activated: Distribution of misclosure is proportional to the 
distance. 

With distances check box is not activated: Distribution of misclosure depends on the num-
ber of back- and foresights. 

Stores value H00 for method of levelling in the batch file: method of levelling = 0 - levelling 
with side shots, measured in the sequence BF. 

Reading sequence: B S S  F S S . 

No evaluation of side shots/turning points: 

Defines a line levelling, i.e., in batch processing only the height differences and the distance 
sum from the starting- to the endpoint will be calculated. As method of levelling, value H10 is 
stored in the batch file: Method of levelling = 1 - line levelling, measured in the sequence BF 

Reading sequence: B F, no side shots. 
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Decimal places 

The parameters Dec. readings and Dec. heights have no influence on the reformatting of 
raw data, but on the calculation output. 

Start of Reformatting 

If all parameters are set correctly and header data are entered, start reformatting by clicking 
the Run button. Data are added to an existing measurement data file (file extension .NIG) of 
the current job. 

Into the Nigra format can be transformed: point number, distance and staff reading (marked 
as backsight, side shot or foresight). 

Staff readings are kept with all digits. Distances are rounded to 2 digits. If the measurement 
was performed in units different from the current Nigra unit of measurement, the measure-
ment data will be converted automatically. 

Before starting batch file calculations, enter the heights of connecting points (Heights menu) 
and start Reorganize Calculation No. (Files menu), if this has not been done automatically.  

 

Start of Batch Calculations 

By entering From calculation no. - To calculation no., either a complete job or part of a job 
may be processed. With Page no., any page number may be set as starting point. 

All fixed-point heights are always searched in the height database of the current job. All 
newly calculated heights are also stored in this database. 

Click now the icon for viewing the calculation: The calculation is shown on the display. 

You can print the calculation from the editor or close the editor and print with the print button. 
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Format Height File 

The heights of all points in raw data, including start- and endpoints, are transferred into the 
height file. The date (maximum of 10 characters) and comments (maximum 30 characters) 
from header data are added. In contrast to the import of ASCII files, the set parameters 
mean value  and stop, if error limit is exceeded are active here. Other parameters, for 
example method of levelling, are meaningless. 

The default setting of the calculation number is 777777. If the mean value of points was 
calculated, a mean value calculation protocol is generated in the calculation file (Calculate 
menu, item View Calculations). 
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Example 

 

To conclude this section, a complete protocol of measurement data is presented. (Measure-
ment with Leica Sprinter from firmware P01.01.03.) 

Sprinter GSI format: 
11....+00000200 32...6+00018619 331.06+00011283 ..... 

11....+00002110 32...6+00038622 333.06+00003281 ..... 

11....+00002111 32...6+00048622 333.06+00004282 ..... 

11....+00002112 32...6+00058617 333.06-00005281 ..... 

11....+00002113 32...6+00068616 333.06+00006281 ..... 

11....+00000000 32...6+00078617 332.06+00008281 ..... 

11....+00000000 32...6+00088621 331.06+00009280 ..... 

11....+00000400 32...6+00098621 332.06+00010281 ..... 

 

Nigra batch file: 

RTest measurement with Leica Sprinter 

x23456789012345678901234567890123456789012345678901234567890123456789012 

x        1         2         3         4         5         6         7 

xDistance<--- Back    Side    Fore ---><--- Point Number --> 

C1 

HSankt Augustin      Location 

H                    Location 

HTest                Order 

H                    Order 

H12a                 Line 

H05/09/2010          Date 

Hsunny               Weather 

HMeyer               Observer 

HLeica-Sprinter      Level 

H4 m                 Staff 

H                    Comments 

H                    Comments 

H00                  2.Col.:0=Side,1=no Side,4=Line, 5=Level test 

*                    3.Col.:0=BF,BBFF,2=BFFB,4=BFBF,5=FBBF,4.Col.:a=altern. 

H1                   Number of staff scales or readings 

H0                   Scale constant for 2 staff graduations 

H7                   Difference tolerance for two readings 

H1                   Staff graduation 1=cm,feet,inches, 0.5=1/2cm 

H1                   With distances, 1=yes, 0=no 

H4                   Decimal places for heights in calculations 

H4                   Decimal places for readings in calculations 

E03m                 E/Mean value/Error class/Unit of measurement 

D    1.86 b1.128300                               200             

D    3.86          s0.328100                     2110             

D    4.86          s0.428200                     2111             

D    5.86          s-0.528100                    2112             

D    6.86          s0.628100                     2113             

D    7.86                   f0.828100                             

D    8.86 b0.928000                                               

D    9.86                   f1.028100             400             

E 
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Calculation: 

Company  XYZ 

NigraWin - Levelling, Version 5.00           05-26-2015    Page: 1  

Job: Sprinter_english 

 

Calculation No.:  1  

Location         Sankt Augustin                         

Order            Test                                   

Line             12a                 Date             05/09/2015          

Weather          sunny               Observer         Meyer               

Level            Leica-Sprinter      Staff            4 m                 

Staff graduation 1 cm                Reading sequence BF BF(S) 

Comments                                                

Calculation of Mean Values: mean value - mean of old and new 

 

Misclosure =        1.3 mm        Max. error E (3) =   2.7 mm 

 

Distance   Back        Side        Fore          Height      Point No. 

  1.86    1.1283                                57.1560            200 

  3.86                0.3281                    57.9563           2110 

  4.86                0.4282                    57.8562           2111 

  5.86               -0.5281                    58.8125           2112 

  6.86                0.6281                    57.6563           2113 

  7.86                            0.8281        57.4566                

  8.86    0.9280 

  9.86                            1.0281        57.3574            400 

 

Sum total distances     =     28.44 m   Delta-H=     0.20010 m 

Sum backsight distances =     10.72 m 

Sum foresight distances =     17.72 m 

  

Sum of all distances (without side shots) =        28.44 m  

Max. misclosure =         1.3 mm      (calcul. no. 1) 
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